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2. КРИВИ НА БЕЗИЕ. НЕПРЕКЪСНАТОСТ. 
АПРОКСИМАЦИЯ. ИНТЕРПОЛАЦИЯ.

СЪЗДАВАНЕ И РЕДАКТИРАНЕ НА ТРАЕКТОРИИ



1. Криви на Безие – история, същност, предимства
2. Непрекъснатост, апроксимация и интерполация
3. Създаване и редактиране на траектории
4. Креативните инструменти в Illustrator
5. Аналогови методи в цифровата ера
6. Поглед в света на точките
7. Метод на часовника или на 

часовниковия механизъм
8. Още методи за векторизиране
9. Добри навици за създаване на илюстрации

СЪДЪРЖАНИЕ:



Страх от математика
1. Травми от училищна възраст.

2. Сложни алгоритми.

3. Черната дъска с нерешима задача на нея...
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Math Is Cool
1. Математиката е навсякъде около нас.
2. Симетрия, геометрия, криви на Безие > 

необходимост при изграждане на вектори.
3. Помага за по-добра композиция.
4. Солидна основа за изграждане на дигитални 

илюстрации.
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Какво е крива на Безие?
1. Формира основните линии на една векторна 

илюстрация.

2. Използва се от всички програми за обработка на 
векторни илюстрации (CorelDraw, Adobe Illustrator, 
InkScape и др.) 
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Какво е крива на Безие?
Кривите на Безие се задават с уравнения. 
Така се дава предимство за по-бърза обработка на 
обекти в компютърната графика. 

Освен това тези представяния имат по-компактна 
форма, в сравнение с тези, изчертани чрез полигони. 
Така обектите, описани с криви, са по-гладки, имат 
възможност да се обработват по-лесно, по-бързо, 
пестят време и памет.
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Какво е крива на Безие?
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InkScape – безплатна
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CorelDraw
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Adobe Illustrator
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Adobe Animate
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InVision Studio
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Кой е Безие?
- Инженер, работил за Рено.
- Главният виновник за 

патентоването
и популяризирането на кривите 
в дигиталното изкуство.

- Преди него е било невъзможно 
да се създадат гладки линии 
чрез софтуер.
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Чрез кривите 
на Безие дизайнерите 
вдъхват живот на 
математическите 
уравнения, като 
създават с тях 
красиви творения.
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Математическо уравнение на крива на Безие
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По-лесно е да научим китайски, отколкото да разберем как да 
начертаем една крива чрез това уравнение!

Благодарение на Безие това няма да ни се наложи!

https://vimeo.com/106757336

или пробвайте играта:

https://bezier.method.ac/
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Математическо уравнение на крива на Безие



Какво трябва да знаем?
1. Векторната графика е изградена от ключови точки 

(котви) и пътища.
2. Всеки сегмент между две такива точки, 

който не е права линия, се нарича крива на Безие.
3. Една илюстрация може да има стотици 

криви на Безие.
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Кога да използваме криви на Безие?
Когато трябва да нарисувате гладки извивки, завои, дъги.

21



Предимства
1. Изображенията са мащабируеми.
2. Не се губи качеството на картината.
3. Подходящи за печат и за 

всякакви рекламни материали.
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В заключение...

23

- Употребата на кривите на Bézier в софтуерите за 
векторна графика промени векторната индустрия.

- Сега може да вземем нашия молив, да скицираме 
нашите идеи и след това да ги дигитализираме 
прецизно чрез векторизиращите програмни 
инструменти. 

- Самото създаване на кривата на Bézier е 
математика, но с новите възможности ние може да я 
използваме за привличащи графични проекти.



Креативните инструменти в Illustrator
Независимо дали използваме Adobe Illustrator, 
CorelDraw, Inkscape или друго приложение първото 
нещо, с което трябва да се запознаем, е списъкът от 
инструменти, с които можем да контролираме тези 
криви на Безие, за да изградим нашия дизайн. 

Всяка векторна програма позволява да се рисуват 
фигури чрез точки, пътеки и основни примитиви.
Illustrator не прави изключение. 



Креативните инструменти в Illustrator

Illustrator предоставя пълен набор от инструменти 
за векторна графика, които се увеличават като брой 
с всяка следваща версия на софтуера. Цели книги са 
посветени на документирането им. 

12 основни инструменти, необходими за 
създаване на точни векторни фигури!



Креативните инструменти в Illustrator
1. Pen tool (P):

Казано най-просто,
точна векторна
графика не би 
било възможно 
да се нарисува
без инструмента 
Pen.



Креативните инструменти в Illustrator

Illustrator ни 
предоставя tooltip, 
който показва 
точните координати в 
пиксели на точката, 
върху която сме в 
момента.



Креативните инструменти в Illustrator
2. Add Anchor Point 
tool (+):
Този инструмент ни
позволява да добавяме
допълнителни
ключови точки върху 
път,
който вече сме 
създали.



Креативните инструменти в Illustrator
3. Delete Anchor 
Point tool (–):
Този инструмент 
ще премахне
всяка точка от 
всеки път,
който сме 
създали, 
без той да 
се прекъсне. 



Креативните инструменти в Illustrator
4. Convert Anchor
Point tool (Shift-C):
Този инструмент
преобразува точки
от криви на Безие 
с цел да се 
превърнат в
прави линии 
или криви. 



Креативните инструменти в Illustrator
4. Convert Anchor
Point tool (Shift-C):
В случай, че рамена (handles) 
липсват, можем да кликнем 
върху съответната точка и да 
ги изтеглим с мишката. 
Ако пък искаме да ги 
премахнем – кликваме 
върху точката отново. 



Креативните инструменти в Illustrator
4. Convert Anchor
Point tool (Shift-C):
В случай, че искаме 
да манипулираме 
самата крива, 
трябва да кликнем 
в средата на 
дъгата й.



Креативните инструменти в Illustrator

5. Selection tool (V):
Използвайте този инструмент,
за да мащабирате обекти.
С него може още да селектиране
целите обекти с
частите им или група обекти. 



Креативните инструменти в Illustrator

6. Direct Selection tool (A):
Този инструмент ни позволява
директно да изберем или
провлачим специфична част
от обект, дори ключова точка
от него. 



Креативните инструменти в Illustrator

7. Rectangle tool (M):
Този инструмент създава
правоъгълници. 



Креативните инструменти в Illustrator

8. Ellipse tool (L):
Този инструмент ще създаде
окръжност или елипса. 



Креативните инструменти в Illustrator

9. Pathfinder tool (Shift-Command-F9 или 
Shift-Control-F9):

Позволява ни да създаваме фигури, изградени от други 
форми, чрез Обединяване на криви (Unite), Изрязване 
на горната фигура, Сечение (Intersect), и режим 
Изключване (Exclude).



Креативните инструменти в Illustrator



Креативните инструменти в Illustrator



Креативните инструменти в Illustrator

10. Rotate tool (R):
Този инструмент ни позволява
да дефинираме оста на завъртане
за всеки избран обект и да го
завъртим в движение или
чрез специфичен
цифровата стойност. 



Креативните инструменти в Illustrator

11. Reflect tool (O):
С този инструмент обръщаме 
избран обект хоризонтално или 
вертикално.
Предимно се използва за
създаване на симетрични 
фигури.



Допълнителни инструменти
за работа с криви

Scissors Tool (C):
Този инструмент не е 
част от групата на Pen 
Tool, но определено 
се асоциира с нея.
Кликнете с мишката 
върху сегмент от 
пътя, за да разделите 
кривата на две части.



Допълнителни инструменти
за работа с криви

Curvature tool 
(Shift+~)      :
Този инструмент e 
eдин от най-новите в 
програмата и помага 
лесно да създадем 
дори идеален кръг,
чрез четири дъги!



Нови полезни инструменти



Нови полезни инструменти



Нови полезни инструменти



Полезни клавишни комбинации
Активиране на Pen Tool (P)
Активиране на Add Anchor Point Tool (+)
Активиране на Delete Anchor Point Tool (-)
Активиране на Convert Anchor Point Tool (Shift-C)
Активиране на Scissors Tool ©
Активиране на Curvature Tool (Shift+~)
Съединяване на 2 Anchor Points (Command/Control-J)



Изгледи на курсора 
при работа с Pen Tool

При работа с Pen Tool-а, курсорът интуитивно приема 
различни образи, според това, какво правите с него. 

(Caps Lock се използва за превключване между 
"pointer" и "cross hair")



Изгледи на курсора при работа с Pen Tool

Подготовка за
изчертаване на път:

Докато сте в средата на създаване 
или редактиране на пътека 
(с декартови координати):



Изгледи на курсора при работа с Pen Tool

При натиснат бутон
на мишката:

При готовност за премахване
на опорна точка (+ за обратното 
действие):



Изгледи на курсора при работа с Pen Tool

При натиснат бутон
На мишката:

При готовност за или при работа с 
част от кривата:



Други клавишни комбинации

1. Задръжте Shift, за да ограничите движението на пътя 
под ъгъл 45°, 90°, 135° или 180° докато създавате или 
редактирате опорни точки или рамена. 
2. Избора на опорна точка с Direct Selection Tool (A) и 
кликване върху Delete. Опорната точка, заедно с 
прилежащия й път ще бъдат изтрити. 
3. Pen Tool-опция (промяна с Alt): променя инструмента 
на Convert Anchor Point Tool.



Полезни съвети при работа с криви
View > Snap to Point



Полезни съвети при работа с криви
Object > Path > Simplify



Полезни съвети при работа с криви
Object > Path > Simplify



Полезни съвети при работа с криви
Издърпайте рамената с мишкато още с първата опорна точка, 
когато започвате да чертаете кривата. 

Добре е издърпаните рамена от вашата крива да са с дължина 
до 1/3 от общия й размер, за да създавате по-гладки криви.



Полезни съвети при работа с криви
Поставяйте опорни точки върху кривата, там където 
искате да смените нейната посока, тоест в началото на 
пътя, а не в средата на дъгата.



Настройка на работната среда
Еdit > Preferences



Настройка на работната среда
Еdit > Preferences



Настройка на работната среда
Еdit > Preferences



Настройка на работната среда
Еdit > Preferences



Създаване на нов документ 



Помощни слоеве

1. Storage Layer (Слой за съхранение на оригинала)

2. Temp Layer (Временен слой)

3. Build Layer (Работен слой)

4. Scan Layer (20% прозрачност за сканиран слой, 
който съдържа растер за векторизиране) 



Как да подреждаме графиките си



Как да подреждаме графиките си



Как да подреждаме графиките си



Аналогови методи в цифровата ера
Аналогови инструменти

Докато скицираме нашите идеи, по време на работа, 
върху даден дизайн, най-често се за скиците е добре да 
използваме: 
1. 2B молив за грубото скициране на концепциите;
2. Химикал за бързо създаване умалени скици;
3. Молив тип тънкописец за по-детайлните части от 
дизайна, което ще ни помогне за по-късната му 
векторизация. 



Аналогови методи в цифровата ера
Събирайте на всички сканирани идеи на един файл,
под формата на малки картинки от тип (thumbnails).

Така се добива общ поглед върху всички дизайни и 
могат да ви дойдат още много нови идеи... 
Това е един "brain dumping" процес.



Аналогови методи в цифровата ера
Изключение от правилото

Както винаги има изключения - за не всички 
проекти е нужно да събираме всички скици.

Трябва да бъдем гъвкави...



Прецизирайте вашите графични скици



Връщане от дигитална към аналогова скица, с цел 
подобряване на качеството или постигане 

на друг ефект като симетрия



Поглед в света на точките
Кривата на Безие или пътя е толкова заоблена, 
елегантна и перфектна, колкото добре сме се 
справили с построяването на ключовите точки от нея.

Ето защо е нужно да познаваме кое класифицира 
една точка към групата на "добрите“, тоест правилно 
построените, а друга – към "лошите" или погрешно 
поставените. 



Правилно построени точки и пътища
Първо, трябва да разберем добре разликата между 
сменяща посоката ключова точка и заобляща точка. 
Първата може да се постави навсякъде в нашата графика, 
където има връх. Този вид точки може да се използват с 
криви на Безие, но можем да минем и без тях.
От друга страна ключовите точки, заоблящи кривите се 
вмъкват там, където един път минава в друг. Този вид 
точки изисква задължителна употреба на водещи линии 
(рамена) от двете и страни, за да можем да контролираме 
достатъчно добре кривата на Безие.





Правилно построени точки, но
с грешни рамена



Грешно поставени точки, 
грозни пътища/криви











Преглед на формите
Идва време да вземете прецизираната 
рисунка от аналогов носител и да я 
“прехвърлим” в дигиталния свят. 

За да направим това прецизно, трябва да 
знаем къде точно да поставим вашите 
ключови точки и кой вид от двата да изберем.



Метод на часовниковия механизъм
Когато фигурата за векторизиране е проста, 
работата ни е лека, но сложните форми 
изискват повече време и преценка коя точка 
къде да поставим. За да улесно този процес на 
построяване на кривите Вон Гличка създава 
метода на часовниковия механизъм 
“The Clockwork Method” (TCM).



Метод на часовниковия механизъм
Същината му се състои в това да си представите 
циферблата на часовника (мислено)  и да го 
завъртите, докато се ориентира заедно с вашите 
фигури в графиката. 
По този начин вие ще го използвате като водач.  



Метод на часовниковия механизъм
Кръгът представя най-простата илюстрацията на TCM.



Метод на часовниковия механизъм



Метод на часовниковия механизъм
Тренирайте мозъкът си

На пръв поглед този метод изглежда малко 
странен, но неговото използване е добър 
мисловен трик, който ни помага с времето 
да изолираме всяка форма или крива и да 
разположим нужните ключови точки на 
правилните места.
 















Още методи за векторизиране
Point-by-Point

1. Грубо
поставяне
на точките

 



Point-by-Point

2. Редакция 
на кривата

 

Още методи за векторизиране



Point-by-Point

3. Поправяне на
Ключовите точки

 

Още методи за векторизиране



Point-by-Point

3. Поправяне на
Ключовите точки

 

Още методи за векторизиране



Point-by-Point

4. Прецизиране
на формата

 

Още методи за векторизиране



Point-by-Point

4. Прецизиране
на формата

 

Още методи за векторизиране



Shape-Building
Method

1. Избор на
основните
фигури

 

Още методи за векторизиране



Добри навици за създаване на илюстрации

1. Дръжте лист и молив под ръка
(или таблета;)

2. Пазете вашите скици с идеи

3. Слоевете са ваши приятели

4. Именовайте си добре файловете



“ Failure is not fatal, but failure
to change might be.”

John Wooden



Източници
GLITSCHKA V., Vector Basic Training: A Systematic Creative Process for Building Precision Vector Artwork, 
New Riders, 2011 by Glitschka Studios, ISBN 10: 0-321-74959-6

http://visual.ly

http://www.designmantic.com
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* Част от материалите от тази лекция
са изготвени съвместно с

доктор Маргарита Атанасова!



За връзка с мен
edesign-bg.com

mstoeva@uni-plovdiv.bg
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